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Working with ScanDir
This topic contains detailed information about the ScanDir configuration and the ScanDir
search function.
Click the '+' sign in the Contents window on the left to expand this topic and select a subtopic for more information.

Configuration
To display the Configuration window click the Configuration button, select Configuration
from the Options pull-down menu, [Alt+C] or press F11. With the configuration window
the settings that ScanDir will use are specified.

Select
Set default file selection criteria. Refer to: Selection criteria for additional information on
using scan arguments.
Sort
[-] Indicate whether or not the Scan entries are sorted (in the drop-down list from the Scan
argument). By default sort is enabled, which means that the Scan arguments are sorted
alphabetically.
Auto complete
[-] Enable or disable auto complete for the Scan argument(s). By default auto complete is
enabled, which means that ScanDir will try to complete the Scan argument after the first
characters have been entered.
Regular Expression
[-] Indicate if the scan argument is a regular expression. For more information on using scan
arguments refer to: Selection criteria.
Or / And / Not
(.) Specify how to interpret the scan argument(s). For more information on using scan
arguments refer to: Selection criteria.
scan sub-directories
[-] indicate if sub-directories should also be scanned. By default sub-directories are also
scanned.
Directories
[-] indicate if directories are included in the scan results. By default, directories are not
shown in the item list. See also (below): Advanced | Calculate directory size.
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Filenames
[-] indicate if filenames are included in the scan results. By default, filenames are always
included in the scan results
Append
[-] indicate if new scan results are added (appended) to the current results. By default,
ScanDir clears the current results with every new Scan cycle.
file
Specify if ScanDir should (not) include the [-] file path, [-] file name and / or [-] file extension
when scanning for filename(s) and / or file mask(s). For more information about file path,
name and extension refer to: Selection criteria.
attributes
Specify the default file attributes that are used during scan operations. For more
information about file attributes refer to: Selection criteria.
size
Specify the default units (Kbytes or Bytes) used to specify the file size. For more information
about file size and file date refer to: Selection criteria.

Scan
Specify settings that are used to control the Scan process.
AutoScan
[-] Set the initial (default) value for AutoScan. If AutoScan is true (selected), ScanDir will
automatically scan the current directory after every directory change. AutoScan can be
temporary enabled or disabled with the AutoScan button (magnifying glass). The default
setting is: AutoScan= true.
Notes:
- With AutoScan only the current directory is scanned (no sub-directories).
- If a search argument is specified it will also be used for AutoScan.
Reset scan string with Dir *.*
[-] Indicate if ScanDir should change the scan string to *.* when the [Dir *.*] button is
pressed. By default ScanDir does not update the search argument when [Dir *.*] is pushed.
Include List when Scanning Tree
[-] Indicate if ScanDir should include the (checked) directory names that are specified in the
directory (include) List when scanning a directory Tree. By default, when the direcrtory Tree
tab is selected, ScanDir will only scan the directory (and sub-directories) that is selected in
the directory Tree.
Include Volume name
[-] Indicate if ScanDir should display the volume name in addition to the drive letter.
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Custom scan string 1 .. 5:
Specify up to 5 scan strings that will be used in the PopUp menu (right-click) for the [Scan]
button..

Output
Item list
Control how the item list is displayed.
(-) NOT sorted - the items are displayed in the sequence in which they were added to the
item list.
(-) Sort Filename - Sort item list on: Filename | filesize | filedate | path
(-) Sort Filepath - Sort item list on: Path | filename | filesize | filedate
(-) Sort Filesize - Sort item list on: Filesize | path | filename | filedate
(-) Sort Filedate - Sort item list on: Filedate | path | filename | filesize
Output
Specify the which fields are included in the output (file / printer).
[-] Include Scan string - include the last scan string used
[-] Include Volume - include volume label
[-] Include Pathname - include pathname
[-] Include Filesize - include filesize
[-] Include Filedate - include filedate
File
Specify how to format file and/or print output.
[-] Include Quoted strings - put all text strings between quotes
[-] Include Title columns- include a line with the column titles
[-] Include Header - include header lines
[-] Include Statistics - include the item list statistics (information as presented in the Info ( i )
window).
Use the following settings to create a .CSV compatible file format which can be imported by
many applications, e.g. MS Access and MS Excel ( these options can also be specified /
changed in the Save as... dialog ):
[v] Quoted strings
[v] Title columns
[-] Header
[-] Statistics
Output delimiter: Select or specify the ( File/Print ) delimiter character ( default= TAB ). To
remain compatible with the ScanDir version 0.3 output file format, select version 0.3 from
the dropdown list.
Output file: specify output filename ( default= \..\scanlist.txt )
(-) Prompt - display a confirmation dialog if the output file already exists;
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(-) Append - append current file to existing file;
(-) Replace - replace existing file by current file;
Print
(-) Report: print lines are grouped per directory. One line is printed for every directory entry,
followed a print line for every file within that directory.
(-) List: print every item on a separate print line. Depending on the Volume / Path / Filesize /
Filedate setting ([font]: Specify the font used for printed output.
Output header: Specify output ( File/Print ) header text ( default= - )

Interface
The interface settings control the way to interact with ScanDir.
Confirm Delete directory
Set the default value for Confirm Delete directory. This default can be temporary
overwritten in the Options menu.
Confirm Rename directory
Set the default value for Confirm Rename directory. This default can be temporary
overwritten in the Options menu.
Confirm Purge file
Set the default value for Confirm Purge file. This default can be temporary overwritten in the
Options menu.
Confirm Delete file
Set the default value for Confirm Delete file. This default can be temporary overwritten in
the Options menu.
Confirm Attrib
Set the default value for Confirm Attrib. This default can be temporary overwritten in the
Options menu.
Confirm Empty
Set the default value for Confirm Empty. This default can be temporary overwritten in the
Options menu.
Confirm Rename file(s)
Set the default value for Confirm Rename. This default can be temporary overwritten in the
Options menu.
Preview Rename file(s)
Set the default value for Preview Rename. This default can be temporary overwritten in the
Options menu.
Progress
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Show or hide scanning progress: display names of directories being scanned in the
statusbar, (use Ctrl+Alt+O to toggle). The default can be temporary overwritten in the View
menu.
Hints
Show or hide hints for all controls (use Ctrl+Alt+H to toggle). The default can be
temporary overwritten in the View menu.
Display Rename pane
Show or hide Rename pane at the bottom of the item list (use Ctrl+Alt+R to toggle). The
default can be temporary overwritten in the View menu.
Save Most Recently Used Directory
Specify if the directory that was last used should be saved and used as the initial directory
the next time ScanDir is started.
Save Window Position and Size
Specify if the current ScanDir window position and size should be stored. The window
position and size will be restored the next time that ScanDir is started.
Save Include list
Indicate if the Include list (directory List tab) should be saved to scandir.log when ScanDir is
stopped.
Save Exclude list
Indicate if the Exclude list (directory Skip tab) should be saved to scandir.log when ScanDir
is stopped.
Save File list
Specify if the file list (File tab) should be saved to scandir.log when ScanDir is stopped.
Save Logfile
Specify if the internal log (Log tab) should be saved to scandir.log when ScanDir is stopped.
Remember Rename parameters
Specify if the parameters for the Rename dialog should be kept. By default, the Rename
parameters are (re)initialized every time the Rename dialog is invoked
Display Preview pane
Show or hide Preview pane at the left, below the directory Tree list.
Skip audio intro
If checked, when an audio file is played, the first 10 seconds of the file are skipped.
History
Save bookmarks
Specify if Bookmarks should be saved.
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Entries
Specify the number of entries to keep for bookmarks (main menu). The minimum number
(=no bookmarks) is: 00, the maximum number is 99. Bookmarks are saved in scandir.ini.
Clear
Press this button to clear the bookmarks entries. Unless ScanDir was started with the
command line option -i (do not use .ini file), this will also clear all bookmark entries saved in
scandir.ini! Clearing bookmarks does NOT reset the Bookmarks Entries number.
Save addresses list
Specify if last address entries used should be saved.
Entries
Specify the number of entries to keep for addresses (main menu). The minimum number
(=no addresses) is: 00, the maximum number is 99. Addresses are saved in scandir.ini.
Clear
Press this button to clear the address entries. Unless ScanDir was started with the command
line option -i (do not use .ini file), this will also clear all address entries saved in scandir.ini!
Clearing addresses does NOT reset the Address Entries number.
Save scan history
Specify if the scan history should be saved in scandir.ini. When the scan history is saved, the
factory supplied defaults may be overwritten. The factory settings can be restored by
clicking the [DEFAULT] button.
Entries
Specify the number of entries to keep in the history (drop-down list). The minimum number
(=no history) is: 00, the maximum number is 99. The Scan history is saved scandir.ini.
Clear
Press this button to clear the history entries. Unless ScanDir was started with the command
line option -i (do not use .ini file), this will also clear any history entries saved in scandir.ini!
Clearing the history does NOT reset the History Size!

Advanced
Show system files
Indicate if System files should be included in the directory Tree.
Show hidden files
Indicate if Hidden files should be included in the directory Tree.
Suppress PopUp message(s)
Check this option to prevent that a PopUp message interrupts a running Scan operation.
Only PopUp messages are suppressed, messages are always written to the log.
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Minimize to system tray
Minimize to system tray instead of taskbar.
Write UTF-8 Unicode files
Indicates whether UTF-8 or ASCII files are written. UTF-8 is the recommended setting. If files
are shared with other applications they may require ASCII files.
Calculate directory size
Indicate if directory (including all sub directories) size should be calculated when scanning
for directories entries. Calculating directory size slows down the scanning process: all file
entries in all sub directories are scanned to calculate the total filesize!!
Item limit
The item limit is the maximum number of output items. Since all items are kept in memory,
increasing this value also increases the memory used by ScanDir. If this limit is reached the
user is prompted to proceed (or not). See also: Error and Warning messages.
Stop Intvl.
The Stop Interval is the number of actions that ScanDir processes before it checks the [Stop]
button. This is a tuning parameter. The larger the number, the faster ScanDir will be. But if
the number is too large, it may take some time before a running process is interrupted
when the [Stop] button is pressed.
[User Font]
Click this button to modify the default font. This option was removed in version 1.3 but has
been restored at user request.
Startup folder
Specify the directory that should be selected when ScanDir is started (ignored if "Save Most
Recently Used directory" is selected).
Target folder
Specify the default directory that Save logfile and Save item list should use.
Directory for Open with...
Specify the default directory to be used when Open with... is selected for an item in the item
list.

Buttons
[Help]
Display Help screen ( the part of the help file that you are currently reading ).
[Reset]
Reset Configuration to the default values. The default values are the factory settings.
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[Save]
Apply and Save the current configuration settings. Configuration settings are written to
scandir.ini.
[Ok]
Set Configuration for current execution of ScanDir only. The configuration settings are NOT
saved.
[Cancel]
Ignore any changes made to the Configuration. Continue with previous Configuration.

Selection criteria
Scan tab
Regular Expression
By default the argument is interpreted as a string or mask. ScanDir also supports regular
expressions as an argument. Check this box if a regular expression is specified.
[-] Regular Expression - (do not) interpret argument as a reguilar expression.
Ignore case
By default, searching for a String is case-insensitive. Check Ignore case to perform a casesensitive String search. This setting is ignored for a Mask. Searching using a Mask is always
case-insensitive.
[-] Ignore case - (do not) distinguish between upper and lower case characters in the search
String.
Or / And / Not
It is possible to specify multiple arguments as string or mask. Multiple arguments are
separated by a blank or comma. When multiple arguments are used, the relation between
these arguments can be specified as:
(-) Or - indicates that at least ONE of the arguments must match
(-) And - indicates that ALL arguments must match
(-) Not - indicates that NONE of the argument may match
Argument
Specify one or more strings, masks and/or extensions. If multiple strings, masks and/or
extensions are specified, they must be separated by a space. The setting of Or / And / Not
determines when a file is selected if multiple selection criteria are specified.
The scan argument is interpreted as either a string, mask or Regular expression. ScanDir
uses the following rules to determine if the argument is a string or a mask:
- if the argument contains an asterisk ( * ) or questionmark ( ? ) it is treated as a mask;
- if the argument does NOT contain asterisks ( * ) or questionmarks ( ? ) it is treated as a
string;
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- if the argument starts with a colon ( : ) it is treated as a mask;
- if the argument starts with a double quote ( " ) it is treated as a string;
Note: You can mix String and Mask arguments. In most cases, ScanDir can distinguish
between Strings and Masks (as described above). You can however force ScanDir to treat
the argument as a Mask, by pre-ceeding it with a semi-colon (:) -or- put the argument
between double quotes (") to treat it as a String.
String

The specified text must occur somewhere in the file path, file name or file extension. Specify
the string(s) you want to scan for. Multiple strings must be separated by a comma ( , ) or
blank ( ). If the string to search for contains comma's or blanks, the entire string must be
placed between double-quotes ( " ).
Example:
the bat scans for the or/and bat, while "the bat" scans for the bat
Mask

The specified text is interpreted as a mask. A valid mask consists of literal characters, sets,
and wildcards. Each literal character must match a single character in the string. The
comparison to literal characters is case-insensitive. Each set begins with an opening bracket
( [ ) and ends with a closing bracket ( ] ). Between the brackets are the elements of the set.
Each element is a literal character or a range. Ranges are specified by an initial value, a dash
( - ), and a final value. Do not use spaces or commas to separate the elements of the set. A
set must match a single character in the string. The character matches the set if it is the
same as one of the literal characters in the set, or if it is in one of the ranges in the set. A
character is in a range if it matches the initial value, the final value, or falls between the two
values. All comparisons are case-insensitive. If the first character after the opening bracket
of a set is an exclamation point ( ! ), then the set matches any character that is not in the
set. Wildcards are asterisks ( * ) or question marks ( ? ). An asterisk matches any number of
characters. A question mark matches a single arbitrary character.
Examples:
Searching for Mask [Ab]* returns all filenames that begin with the letter A, a, B or b.
Remember that searching with a Mask is always case-insensitive.
Searching for String test gives the same results as searching for the Mask *test*, but
searching for a String is faster.

Filenames
By default (only) filenames are included in the scan result item list. Uncheck Filenames to
exclude filenames from the scan results.
[-] Filenames - (do not) include filename entries in the scan results.
Directories
By default directory entries are excluded from the scan result item list. Check Directories if
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directory entry names should also be included in the scan results.
[-] Directories - (do not) include directory entries in the scan results.
scan sub-directories
By default all sub-directories under the current directory are also scanned. Uncheck scan
sub-directories if only the current directory should be scanned.
[-] scan sub-directories - (do not) scan sub-directories.
Note: the sub-directories setting is ignored by [Dir *.*].
Append
[-] Append results. Use this checkbox if the scan results should be added to the current item
list. Normally, the item list is cleared before every new scan operation. If the [Dir *.*] button
is pressed, the current item list is always cleared.

File tab
Mark one or more of the following checkboxes to specify whether ScanDir should examine
the file path, file name and /or file extension to find a match for the search argument.
[-] File path – scan the file path
[-] File name – scan the file name
[-] File extension – scan the file extension

Attrib tab
Select one or more options:
[-] All files – select all files regardless what attribute(s) they have
[-] Normal files – select files that have no special attributes (FAT32)
[-] Normal files – select files with N (normal) attribute (NTFS)
[-] System – select files with S (system) attribute
[-] Hidden – select files with H (hidden) attribute
[-] Read only - select files with R (read only) attribute
[-] Archive - select files with A (archive) attribute
[-] Volume ID - select volume id entries

Size tab
Select one or more options:
[-] Min. - specify minimum filesize
[-] Max. - specify maximum filesize
[GBytes], [MBytes], [Kbytes], [bytes] switch between filesize in GigaBytes, MegaBytes,
KiloBytes or Bytes

Modified tab
Select files based on the Date modified.
Date
[-] From - specify from date
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[-] To - specify to date
Time
[-] From - specify from time
[-] To - specify to time

Created tab
Select files based on the Date created.
Date
[-] From - specify from date
[-] To - specify to date
Time
[-] From - specify from time
[-] To - specify to time
Hit the [Scan] button to start scanning.
Right-click the [Scan] button to select a pre-defined scan string from the PopUp menu;

Keyboard
Shortkeys
The following short keys are defined:
Alt+B manage Bookmarks.
Alt+C Configuration.
Alt+F display File info for selected items
Alt+F4 Exit ScanDir.
Alt+H display Help.
Alt+I dropdown Items menu.
Alt+O dropdown Options menu.
Alt+P Print item list (using Print dialog).
Alt+S Save item list to a file.
Alt+V dropdown View menu.
Ctrl+A Select All items in item list.
Ctrl+B Bookmark current directory.
Ctrl+Shift+B Bookmark directory from selected item.
Ctrl+C Copy selected text to clipboard.
Ctrl+C Copy selected file(s).
Ctrl+D Delete selected file(s).
Ctrl+Shift+D Purge selected file(s).
Ctrl+Shift+F copy Filename(s) (without path) to clipboard.
Ctrl+J Split / Join selected files.
Ctrl+M Move selected file(s).
Ctrl+N select None, de-select all items in item list.
Ctrl+O Open selected file
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Ctrl+P Print item list to default printer (no Print dialog).
Ctrl+Shift+P copy Path and Filename(s) to clipboard.
Ctrl+R Rename selected file(s).
Ctrl+Alt+R Toggle Rename pane.
Ctrl+S Sort items in item list.
Ctrl+T Set Attributes for selected file(s).
Ctrl+V Paste text from clipboard.
Ctrl+Alt+V Toggle (pre)View pane.
Ctrl+X Cut selected text to clipboard.
Ctrl+X Exclude selected file(s) from item list.
Del Delete file, works only within item list.
Esc Escape, stop (interrupt) running scan.
Shitf+D move selected item Down in list
Shift+U move selected item Up in list
Shift+L select List tab.
Shift+T select Tree tab.
Shift+X select Exclude tab.
Shift+V select View tab.
F1 Help
F2 Refresh directory list
F3 Dir *.*
F4 Scan
F5 Copy
F6 Move
F7 Rename
F8 Delete
F9 Purge
F10 - not used F11 Configuration
F12 select Info tab
PgUp Scroll back (prev) in item list.
PgDn Scroll forward (next) in item list.

3/5/2019

